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Getting Started
The user needs to register at the KSDE Web Applications website https://online.ksde.org/authentication/login.aspx. If you already have access to the KSDE Web
Applications, then a new registration is not required.
To gain access to Personnel Web application select Manage My Account, then select Personnel Web
System. You (or the Special Education Director, or the person you are replacing) should also send the
person managing Personnel Web at KSDE an email letting them know you are authorized for access.
The request to add Personnel Web will be manually approved, the user will be notified and Personnel
Web may be accessed through the Authenticated Applications login.
Once logged in, the first screen opened by the application will then be the blank main page that says
“Personnel Web System” across the top (at the start of a new fiscal year, when the first screen is the
Begin Year Setup). From the Personnel Menu System you can navigate to all the necessary pages
needed to log out, edit data, view data, change user info, view and print reports, and access the help
document.
Don’t use the back button. It will not work and it will force you to login again. Most of the pages in
Personnel Web are not cached for security purposes. Use the menu system to navigate through
Personnel Web. Use the Log Off menu option in the Personnel menu before going on to another website
or before closing the browser. This is a security measure to help keep the data secure.
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General information
Personnel Web is split into two sessions, “Summer” which is the special education Extended School
Year, and “Regular” which is the standard fall to spring school year. The same entering rules apply to
both, there is no difference in licensing requirements or the way the program operates. There are no
“substitutes” in summer session.
Licenses and certifications are checked based on the dates a person is reported to be working and the
area of assignment. There is a chart of the possible assignment areas under resources in the special
education pages at KSDE.org. Teachers are also checked against endorsement grade levels.
The program recognizes two classes of employees to be reimbursed, professionals and nonprofessionals (“P” or “N”). Professionals are people such as classroom teachers, administrators, and
licensed personnel, who are able to work without supervision. Non-professionals are paraeducators,
non-licensed personnel, and those whose license requires supervision (such as an Occupational
Therapist Assistant) who are supervised by licensed personnel. “Special Teacher” in Kansas law
includes related service personnel, and so includes various licensed professions as well as classroom
teachers as professionals. “Para” is used generally in this guide to include all non-professionals.
Non-professionals must have a supervisor listed in the program at all times. Usually, paras are assigned
in the same building as the professional supervising them and the professional’s assignment time covers
the para’s assignment time, but other situations are possible.
When adding new people through the year, you must add the person first, then add their assignment.
Additionally, if the new person is a para, and is supervised by a new teacher, you must add the teacher
and the teacher’s assignment before adding the para and the para’s assignment (supervised by the
teacher)
It is a good idea to update Personnel Web when personnel changes. Updating throughout the year
means that the payment information reflects the most accurate possible information, gives you the most
time to find and correct errors, and helps identify possible problems early.
It is important to realize that the system currently does not check information as it is entered for
“payability”. The system checks for certain logical errors (start dates before end dates, para assignment
dates/buildings/areas matching the supervisor, etc) but does not check assignments against licenses or
teaching certificates/endorsements until the payment is run. Personnel Web is currently in the process of
being rewritten, but until then, we have to work with the system that exists. It is very important to check
reports on every payment. Even if someone pays on one payment, an issue could come up with their
license that needs to be adjusted. Some time spent reviewing reports could mean additional funding for
your district!

The Edit Menu
(adding/editing people, assignments, inservice, vacancies, sub approvals)
To add a person/assignment, you will need the following information:
Social Security Number
Last name
First name
Middle Initial (optional)
Regular or Summer (ESY)
Building Number
Area of assignment
Low and High level of assignment
Start and End date of assignment
Hours or FTE
If the person is being paid on contract, the contracted FTE
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If the person is being paid hourly, the expected hours to be worked

Adding or Editing a Person
Edit>People
People added to the system will not show up unless they have an assignment,
but people are not deleted from the system when they do not have an
assignment. So if someone has returned to the district and do not have a current
assignment, they will not show up in the “people” list, but they do not need to be
added again.
For new personnel to the district, always add the person first, then the
assignment.
Editing a person is done in the same screen, merely select the person from the list shown. When a
person changes their last name, enter the previous name into “Former” and the new name as the “Last”
as a reference.

Adding or Editing an
Assignment
Edit>choose Reg(ular) or Sum(mer)
The basics of adding or editing assignments
are the same for professional and
paraeducators. Please read the
professional description for the process in
detail, the paraeducator description will only
cover the additional steps. To edit any
assignment, merely click “Edit” to the left of
the existing assignment.
Professional Assignments:
Enter the Social Security number (SSN) of the person who
will hold this assignment. If that person is on record the
people information will be populated for you. If the person
is not on file, stop and go enter them into the people
datafile, you cannot add people in the assignment screen.
LEA/Fiscal Year/Term are all filled out for you. Supervisor
is not applicable because this is a professional entry.
Building is the identification number of the building. The
state directory should have the current list of building
numbers for your district.
The area of assignment is determined by the services the
teacher is contracted to provide. “IR” is not the correct
selection in every situation.
Low and High levels refer to the grade range the teacher
will be teaching, not the building the teacher will be
working in or their certification.
Start and End Dates should be the first and last day the students are in the classroom for full year
employees. Partial year employees should use the start and/or end dates that coincide with their
employment (and fall within dates students are in the classroom).
Contract refers to the FTE the teacher is contracted to teach. Enter as a decimal (1.0, .33, etc.)
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Hours is used mainly for paras. IF a teacher is paid hourly (turns in a time sheet) then you may fill in the
estimated hours the teacher will be working (actual hours if the assignment is being edited at the end of
the year).
“Assign FTE” is filled in by the program based on the contract FTE or hours entered, and not exceeding 1
FTE for all assignments. (OA area of assignment is the only area of assignment that will allow greater
than 1 FTE)
If you will be adding additional assignments, and the dates and FTE will be the same, click the “Carry
Forward” box then “Add Another” to get a fresh assignment sheet, otherwise simply select “Save” or
“Cancel” to save or delete the current assignment and return to the assignment overview
If you are editing an existing assignment, “Cancel” is replaced by “Delete”. If you delete a supervising
teacher’s assignment, the unassigned paras will be highlighted. You can reassign the paras to another
teacher by editing their assignments and clicking on “reassign”.
Adding Paraeducator Assignments
The major difference is that when you add a new para
assignment, you first select the supervisors Social Security
Number. A list of the professional’s assignments will be
displayed to select the assignment the para is working under. If
the supervisor has only one assignment the form will be
populated with the data from that assignment. You may make
any changes to fields such as the start or end date if different from the professionals, then enter the
para’s hours to generate an FTE amount.
Why you might need more than one assignment for a single special teacher or paraeducator
If the teacher is assigned to the area of IT (infant toddler) or is teaching at the level of IT, then both
teaching levels must be IT. Infant Toddler is funded through a separate federal program (Part C of IDEA)
and for federal reporting purposes, the funds must be separated. If someone is working with both IT and
Part B (EC-12) levels, then there must be separate assignments for IT and for the other levels.
Separate entries must be made on the KSDE Special Education Personnel Report to reflect the
assignments of persons with duties in more than one area/field (e.g., 0.50 FTE behavior disorders
special teacher and 0.50 FTE special education supervisor; or 0.33 FTE special education instructional
media, 0.33 FTE learning disabilities special teacher, and 0.34 FTE special education supervisor). Para
assignments must be split to match their supervising special teacher(s)
If a teacher is working in more than one building, they should have an assignment for each building,
however, if the teacher works in a variety of buildings/districts (such as a gifted teacher for a coop) then
select one building to use as the “home building” (usually the administrative building).
If a teacher changes license type (for example, a teacher switches to a substitute for part of the year
because their endorsement for special education is not renewed) then a second assignment must be
made for the change in license type. Remember that any para
assignments must also match the additional assignment(s).
If you need to locate an existing record, you can search for or
sort the data.
After locating an assignment, select that record by clicking “EDIT”
in the left column of the data grid.
Should you get this warning, please let the Personnel Web manager
at KSDE know if you change the assignment. The “special status”
will have to be reset manually. If you did not make any changes,
please “cancel” rather than “save” to exit.
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Paraeducator Inservice
Edit>Inservice
As specified in the Reimbursement Guide,
paraeducators must have staff development. The
Edit Inservice menu option allows you to edit para
inservice information: inservice hours, college credit
hours, and tiered requirements, of the para.
All your assigned paras will be displayed. If there is
no tier # listed, you will need to “Edit” that record. The para name and SSN
will be displayed, select the correct tier from the 3 options. By selecting the
first or second options (tier 1 or tier 2), the program will calculate the number
of inservice hours for each para based on the dates they are assigned to
work. Enter College Hours as the hours earned (3 college hours, enter 3).
The program will change them into inservice hours.




Tier 1 = less than the 3 past years as a Kansas special education para (20
hours)
Tier 2 = 3 or more of the past 3 years as a Kansas special ed para (10
hours))
Tier 3 = currently licensed as teacher (not sub or esub only), OTA, PTA,
LPN, etc (inservice locally determined)

If you select that a para has a current Kansas license/certificate, then you
must select one of the available options.
“Related Service Provider eligible for
Professional level categorical aid” only applies if
the profession they are licensed in applies to the
area in which they are a para.

Edit Substitutes
When a teacher (professional) is on non-paid leave, or
has left, a substitute may be reimbursed for that
position. The reimbursement guide has more
information on what substitutes are allowed and for
how long, but they must be a KSDE endorsed teacher
or hold a substitute or esub license, and the position
must be one held by a teacher, not a “related service”
professional. An OT, PT, SLP, etc position can only be
filled by someone with the correct license. KSDE
cannot override the licensing requirements of other
professions.
Edit>SubApprovals
If you make major changes to the sub approval form
after it is first submitted, you might let the Personnel
Web Manager know. Once approved, no information
on sub approval can be changed or deleted.
Add the replacement/substitute in the People file, and
then create a new assignment for the substitute.
Remember to end the teacher’s assignment in the
system as well as the assignments of their paras. Add
the replacement/substitute in the People file, then
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create a new assignment for the replacement or the substitute and assign the paras to them (unless the
paras are being supervised by another teacher). Substitutes must currently be manually approved if the
substitute does not have the correct special education endorsement for the assignment, so fill out the
sub approval form in Personnel Web for classroom teachers.
For related service personnel, a replacement/substitute must have the required license/certification for
the assignment, so simply create a new assignment and reassign any non-professionals to the new
professional.
Fill out the information required, the assignment information must match the teacher who is being
substituted for.
It is expected that districts will make every attempt to find qualified people to work in special education
classrooms. In the box under number 7, you can put an explanation of why the sub is the best person to
fill in for the teacher.
Substitutes can only be claimed when the regular teacher is not being paid, so only long term absences
or vacant positions.
The total FTE claimed for the substitute in one classroom cannot exceed the FTE allowed by regulation
(see reimbursement guide, or the approval section at the bottom of the form). The FTE for the teacher
should be reduced by at least the amount of FTE claimed for the substitute.

Waivers
Teachers who are in the process of qualifying for a new endorsement can get a waiver of requirements
allowing them to teach in the area they are working on. Waivers have to be applied for early in the year
because the Kansas Board of Education has to approve them after all the information is verified by
Teacher Licensure. Once a teacher has a waiver for an area (which usually covers the whole school
year) it will count the same as a full endorsement in that area. If someone is likely to get a waiver, don’t
put them in the program as a substitute; wait for the waiver to be approved or disapproved. Waivers
aren’t automatically added, but must be manually added. The personnel web manager will pull the list of
approved waivers from the Board of Education items, but if one is missed, please send an email.

The View Menu
The View menu lets you view (but not edit) reference screens (levels,
areas) and district information (people, assignments). Areas and levels
open in popups so you can have them open while you are working on
assignments.

View>Certificates
You can view the endorsements and licensure KSDE has on file for a specific Social
Security Number if the teacher is claimed for categorical aid. Every endorsement,
past and current will be shown, sorted by the endorsement number.
Following is the sort of information you will see for ONE social security number
(remember, the person must also be in the “people” file for you to pull their
information through Personnel Web).
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The name is the name that Teacher Licensure has on file for this social security number.
There are many types of licenses a teacher can have, with few exceptions they count as “professional”
for purposes of reimbursement. The main exceptions are “SUB” and “ESUB” which are only
reimbursable as substitutes and are limited by regulation as to how much FTE they can claim in an
assignment.
There is a list of endorsement numbers that are reimbursable on the KSDE resources page. . Every time
an endorsement is renewed, there will be a new entry.
Low and High are the grade limits of each endorsement.
Cert Orig is the origination date of the license type (PROF, STD3YR, etc) NOT always the date of the
endorsement. The endorsement origination date is not present on every record.
I know this is not the easiest screen to read, and the consultants at Teacher Licensure (785-291-3678)
will always be happy to help with questions. But you CAN resolve some errors with this screen, such as
“Certificate Name Error”, “No Endorsement For Level”, etc. Always remember that the assignment
should reflect what the teacher is actually doing to avoid issues during the audit. But if the teacher is
teaching grade 6, has a license for K-6, and the building is 5-8, the teacher will pay correctly with levels
6-6, which reflects the actual assignment and is also covered by the teacher’s license.

The Reports Menu
The report screens all work in the same manner and are similar in appearance.
Each will prompt you for specifics to the report being run. You can select sort criteria
from the list by clicking the “>>>” button or remove sort criteria by clicking on the
“<<<” button. After you select your criteria, click ‘Get Report’ and it will retrieve your
report in html format where you can view the report. From here, you can export the
report to a Word, PDF, Excel, or Rich Text Format File.
Assignment List
The Assignment List report displays data about all of the professionals and
paraeducators that are being claimed for categorical aid reimbursement and gives
you a tally of full time equivalences for professionals and paras.
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Error List
The Error List report displays data about assignments that have errors and the errors contained in those
assignments. This does NOT list all the non-payment issues, only those that have an error message
Over 1.0 FTE
The Over 1.0 FTE report displays data about personnel who have more than a 1.0 full time equivalency.
These are not necessarily wrong, but they will be looked at so be sure you can verify the time your
district claims.
Para Inservice
The Para Inservice report contains data about paraeducators and their progress with inservice training
hours, and college credit hours.
Inservice Required
The Inservice Required report contains data about paraeducators and their progress with inservice
training. It can be used to calculate the inservice hours that are required for individuals that quit prior to
completing the full term of their assignment or start late in the year. Paras who have completed the
required inservice or do not have a tier selected do not show up on this report.
Vacancy
The Vacancy report contains data about any vacant available budgeted positions within a district or coop.
Deadline for adding vacancies is April 15th every year.
FTE Discrepancy
This lists people who have a portion of assignment time that is not paying for some reason (generally
license related). This report can be used to see what staff need to renew licensure.
Payment
This is the list of all the people you reported, and exactly how the system processed their information.
There have been people who did not pay and who did not show up on the error or discrepancy reports,
so please review this report. The payment report is the main report that should be kept (not the only
report that can be kept, but if you only keep one report, make it this one).
Payment (Building)
The Payment (Building) report contains the same data as the above payment report except it is grouped
by buildings within each district. This can be useful if information needs to be reviewed by different
people to limit distribution of personal information.
Directory By Area
The Directory by area report contains data for all professionals and paraeducators reported listed by
area.

Personnel Web Errors
These are most of the errors you may encounter on the payment report and generally how to deal with them. You
can always call or email with questions.

Certificate Name Error
Teacher Licensure has a different name for the teacher. Use View>Certificates to check.
Certificate Not Effective
The teacher has the correct certification, but the certification dates do not cover the assignment.
If the teacher was licensed during the assignment dates, you may put in a sub approval request.
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Expired Certificate
Similar to “Certificate Not Effective”. If the special education endorsement is expired, but the
teacher is still licensed, you may put in a sub approval request.
Expired License
IF this is BR/ MT/OM/RE/IN then you need to send the license in. IF it is another licensed area,
then there may be a problem with the licensure. The Personnel Web Manager will check licenses
online when possible and update them before each payment.
Invalid Area For Certificate
The teacher is assigned in an area they are not endorsed for. A sub approval might be
requested if the assignment is correct.
Invalid Area For License
There is a license on file, but the assignment is in a different area. OT/PT are easy to mix up and
get this error. Check the area of the assignment.
Invalid Building Number
The building number is not in the personnel web system. Double check, and if the number is
correct, send in the building number and address (street, city, zip) and the Personnel Web
Manager will add the building to this system.
License Name Error
The license in the system has a different name than the assigned person (but the social security
numbers match) The name (last name particularly) must be the name on the license. If the
license name is the same, call/email the Personnel Web Manager.
No Certificate
There is no teaching certificate on file. Check the area of assignment and the social security
number of the teacher. If you can see the teacher’s certification on the Teacher Education and
Licensure site, then call/email the Personnel Web Manager.
No Endorsement For Level
The teacher is assigned outside of the levels of the endorsement. A sub approval may be
submitted if the assignment is correct.
No License
There is no license in the personnel web file. If the area is BR/ MT/OM/RE/IN, then the license
must be sent in. If it is another area, then just send an email with the person’s name/area/license
number and I will look them up online and add them.
No Professional Assignment
Usually these are a database error where the Para has lost the assignment connection to the
professional. Delete the para assignment then re-enter.. If the error occurs for a para with a
supervisor out of district, the assignment will need to be hand approved.

Vacancy Report
Entering and Viewing the Vacancy report are explained here, because it
is usually completed at the end of the school year. This report is used to
show the number and type of unfilled budgeted positions in the state of
Kansas.
The Edit Vacancy menu option allows you to add, edit, or delete vacancy
information like date available, prof or para, new or replacement, area,
low level, high level, and FTE of the vacant position. If your district has
no budgeted positions for the year that are unfilled, then you have
nothing to enter here and you do not need to notify the Personnel Web
Manager.
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Begin Year Setup
At the start of each new school year, you will be starting with all of the records from the previous year.
The Begin Year Setup process is to carry over assignments/people that are still with your district and
give them the dates for the new year and delete any assignments/people that are no longer needed. The
first person to log on for your district will be doing the setup. If you have summer assignments, they are
presented first, then Regular assignments.
Buildings/people/assignments that are brand new for the term (summer or regular) will be entered after
this process is complete.
The information you must have is the start and end dates for the summer (ESY) session, and the dates
for the regular school year. If you have a list of people who are not with the district anymore, you can
easily delete their assignments during the setup process but the assignments may also be deleted after
setup is complete.
Enter District, click OK
Click on Set Dates

Select Building(s) by checking each or using the
CHECK ALL button
Enter the Start and End dates
Click on Add Dates
Upon clicking “Add Dates”, the dates should
populate in the building grid and the Process
Dates button is enabled.
Any listed buildings you do not set dates for will
be left with the same dates on assignments as
the previous fiscal year (the year will be
updated)
If there are no assignments for a building, the
building will not
be listed. If
there are new buildings in the district to be added for the new year,
please send the: Building number, LEA #, Address (of the building), City
, Zip to the Personnel Web Manager ASAP to get added to the system.
Once you have verified the dates and buildings, click PROCESS DATES. Click the CANCEL button to
return to the previous screen at any time.
The next screen returned should have the Process button enabled. Click PROCESS to continue setting
the dates.
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If you had Summer Assignments in the previous fiscal year, you will need to perform these steps for
Summer Term, then repeat for Regular Term.
Regular Term: Any assignments
ending prior to May 1st the
previous Fiscal Year will be
already automatically deleted.
Once you Process the Regular
Term Setup page you will be
directed to the Main page. All the
users in your district that work with
the Personnel Web System will be
set to regular mode so when
logging in everyone will go directly
to the Main page and the setup
will not be run again until the next
Fiscal Year.
Note that for both summer and
regular term setup there is a “Log
Off” button. If you click this it will
not save any changes made on
the current page and you will be forced to run through setup again upon your next log in. However if you
log off in regular term the summer assignments deleted are already permanently deleted. You can still
delete additional assignments if there are any. You can also make changes to the dates on the existing
buildings the next time through the new year setup.

DELETING AN ASSIGNMENT – you can check the box next to the assignment, or choose “Check
All” or “Clear All”. When you click on “PROCESS”, it will delete those checked records.

WARNING! This is a DELETE function and it is possible to delete all assignments if you are not paying
close attention. If you accidentally delete all assignments, you can request the district data be reset.
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